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Introduction

DocuShare product editions

Xerox DocuShare provides several product editions. Depending on which product edition you are
using, certain features and add-ons are available.

Note: DocuShare Express is not available in all geographies.

DocuShare documentation describes all product features and add-ons. Refer to the below table to
see which features and add-ons are available for your use.

Product comparison

DocuShare DocuShare DocuShare
DocuShare

Express Education Enterprise

Document Check-in / Check-out . . . .
and Version History

Access Permissions . . . .
Expanded Permission Set . . . .
Full Text and Property Indexing . . . .
and Search

Notifications o . . o
Change History / Activity History | e . . .
Document Routing and Approval | e . . o
Side-by-Side Document Content . . . .
and Property Viewer

Scan Cover Sheets . . . .
Document Comments . . . o
Weblogs and Wikis . . o
HTML Conversion . . . .
Custom Properties Creation . . . .
Custom Object Creation . . .
Document and Permission . . .
Reports

DocuShare SharePoint . . o

Integration

LDAP Support . . .
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Product comparison

DocuShare DocuShare DocuShare
Express Education DocuShare Enterprise
WebDAV Support . . . .
Product Add-ons
Application Connector Add-on Add-on Add-on
Archive Server Add-on Add-on Add-on
Content Encryption Add-on Add-on
Content Rules Manager (content Add-on Add-on .
rules / workspaces features)
Database Connectors Add-on Add-on .
eForms Add-on Add-on Add-on
Email Agent Add-on Add-on .
Federated Search Add-on Add-on .
OCR Service Add-on Add-on
PDF Conversion Add-on . .
Quick Search . Add-on . .
Records Manager Add-on Add-on
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Getting started

Overview

The DocuShare family of products allow you to easily and efficiently manage electronic content
using a web browser. Using DocuShare, you can create, organize, and share content, collaborate
with other users on projects, search for and retrieve content, and automate work processes.

Key features in the products enable you to:

Create and maintain your own account and personal work area without the assistance of a
web master or site administrator.

Add and control access to site content.

Maintain multiple versions of a document, track its revision history, and lock a document to
prevent simultaneous editing.

Collaborate on content using wikis and weblogs.

Scan paper documents to site locations.

Route documents for approval or review.

Create project-oriented areas for managing the content, people, and tasks.

Set up content rules to automate a work process.

Xerox® DocuShare® User Guide 1
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Accessing DocuShare

You access DocuShare by entering the URL of your DocuShare site in a web browser window.
Depending on how your site is set up, you may be required to log in or you see the DocuShare
home page. From the site home page you can log in, as well as access the content and features on
your site.

Although your administrator can customize your site home page and different browsers may not
display site elements the same, your home page should look similar to the example shown below.

Xerox DocuShare®znrererise B) - a B Advnced Y cmogen | Logos

1+ MY DOCUSHARE 8 MYTASKS ¥ MY FAVORITES Q, QUICK SEARCH ®

cENT

GETTING STARTED ‘

q Not sure what to do? m
COMMUNITIES
Explore our community areas E) ((z

HB Workspaces

22 mars

Wikis sss mors
< OTHER LINKS [
Top level collections = Links to other content C// Weblogs === ore
D Initial Top Level Collection A ﬁ My DocuShare
iti i = WHAT'S NEW F )
D nalTop tevelCalecton _ Content Rules Management Lists all modified content. See what's new Q

today!
D Initial Top Level Collection C

Period
D Initial Top Level Collection D

Groups Cuick S2arch =ome  Haip

The DocuShare home page includes these features:
A.  Thesite's top-level collections, which your administrator sets up

B. Navigation bar, which includes links to frequently used pages and a search area for
running simple searches and accessing advanced search features

C.  Other links, which include My DocuShare, your personalized home page, and pages for
other features, if available

D. Page footer, which includes links to other DocuShare pages and help information
Access to community areas

F.  What's New menu, which you can use to see the content that has been recently added
or changed

Navigating DocuShare

DocuShare navigation features make it easy to find what you need.

Xerox® DocuShare® User Guide 12



Logging in and out Xerox® DocuShare®

Navigation bar—Includes links to pages and features that are used frequently:
o Home—returns to the home page.

. My DocuShare—displays your personal home page, which includes your favorites, a personal
collection, calendar and more. The link displays after you log in and on pages other than the
DocuShare home page.

. My Tasks—opens in a new window to show the routing tasks assigned to you and the tasks
you assigned. The link displays after you log in.

o My Favorites—opens in a new window to show items you have added to the list.
. Recent—lists the new and changed objects on your site.

. Search area—includes an area for running simple searches as well as a link to the Advanced
Search page.

. Username—displays your user account properties. Your username displays after you log into
DocuShare.

o Logout—Ilogs you out of DocuShare. The link displays after you log in.

Page footer—Provides links to related information and:
. Users & Groups—provides links to listing, finding, and creating user and group accounts.
o Help—provides access to user guides, tutorials, and software downloads.

. Content Map— a hierarchical display of the objects on your site, based on your current
location. You can click any object in the Content Map to open it. Depending on how your site
is set up, this link may not appear.

Breadcrumbs—Provide a path from the home page to your current location or list the last few
pages you visited. You can click any link in the breadcrumbs to go to the page.

Location: Home \ Initial Top Level Collection D \ My Collection Listing

Logging in and out

Your administrator determines the access policies for your site. Therefore, you may be able to
browse and view content without logging in (as a guest) or you may be required to log in before
you can access any site content.
To log into DocuShare:
1. Inaweb browser, enter the URL of your DocuShare site.
2. Inthe Login areaq, enter your registered username and password in the fields.

Your password is case-sensitive.

3. Inthe Domain field, select your internal domain name (if applicable).

4. If the Retain login for future checkbox appears, click it if you want your username and
password to be retained. This will make logging into DocuShare easier in the future.

Note: The Retain login for future checkbox only appears if your administrator has
configured your site to allow users to do this.
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5. Click Login.

Your username appears on the navigation bar, indicating that you are logged in.

To log out of DocuShare:
1. Do one of the following:
—  Close the browser window.

—  Click the Logout button on the navigation bar.

How to get help

In addition to this guide, the Help Desk includes other guides and a tutorial. The Documentation
page provides user guides for the features available on your site. The Training page includes a
User Tutorial, which helps you get started using DocuShare by following a series of step-by-step
exercises.

Xerox® DocuShare® User Guide 14



Managing accounts

About accounts

DocuShare provides two types of accounts: individual user accounts and group accounts. Your
administrator determines who can create each type of account on your site. For example, your site
might allow a guest (someone who can view public content) to create a user account, but require
an administrator to create group accounts.

When a user account is created, either by you or an administrator, it is assigned a user level. The
user level controls the level of access to site content and functions. One of the following user levels
is specified when creating a user account:

. Read-Only—Allows the user to view content and manage personal content on My
DocuShare.

. DocuShare—Allows the user to access all DocuShare content management functions.
o CPX—Allows the user to access all DocuShare CPX content and process management

functions.

After the user account is created, the user level assigned to the account is indicated by the
superscript letters appearing after the username: read-only, DS, or CPX.

Note: If your site uses the LDAP (Lightweight Directory Access Protocol) feature to manage

user accounts, an administrator creates an account for you. To find out how your site is
configured, see your DocuShare administrator.

User accounts

To add and edit content, you must have a DocuShare user account.

Creating a user account

If your site allows a guest to create accounts, you can create a user account. If account creation is
restricted, an administrator will need to create a user account for you.

To create a user account:

1. Onthe page footer, click Users & Groups.

2. Click the Add User link.

3. Onthe Add User page, enter the following information:

Username—The name used to log into DocuShare.

Xerox® DocuShare® User Guide 15
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Password and Password Confirm—The password used to log into DocuShare. Your
administrator can specify that passwords adhere to a set of rules. If specified, the rules
appear on the page.

Passwords are case-sensitive and must be typed as specified when logging in.

Domain—An organization or other entity on your DocuShare site. The menu lists internal
domains only.

User Level—The level of access to site content and functions.

Last Name—The last name of the user. Users are listed on the DocuShare site by their first
and last names.

4. Enter any optional information. Click a field name for a description of each property.

Note: If your administrator created custom properties, they also display on the page.
See your administrator for information about custom properties.

5. Click Apply.
The View Properties page for the user account appears.

If DocuShare was unable to create a new account, a message page appears describing the
problem.

Viewing user account properties

You can view the properties of any DocuShare user account.

To view a user’s account properties:

1. Locate and select the user whose properties you want to view. To search for a user, see
Finding and listing site accounts on page 25.

The View Properties page appears, displaying the user’s properties. Click a field name for a
description of each property.

Changing your user account properties

Another user can view, but not change, your user account properties. To change your user account
properties, you must first log in.

To change your user account properties:

1. On the navigation bar, click your username.

On the View Properties page, click the Edit link.

Change the properties you want. Click a field name for a description of each property.

Click Apply.

5 WwWN
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Changing your password

To change your password you must first log in. Another user cannot change your password.

Note: If your site uses the LDAP feature, you cannot change your password. Your
administrator must change your password on the LDAP server.

To change your current password:
1. On the navigation bar, click your username.
On the View Properties page, click the Change Password link.

Enter your current password in the Old Password field.

W

Enter your new password in the New Password field.

Your administrator can specify that passwords adhere to a set of rules. If specified, the rules
appear on the page.

5. Enter your new password in the New Password Confirm field.

6.  Click Apply.

Changing your username

To change your username, you must first log in. Another user cannot change your username.

Note: If your site uses the LDAP feature, you cannot change your username. Your
administrator must change your username on the LDAP server.

To change your username:

1. On the navigation bar, click your username.

On the View Properties page, click the Change Username link.
Enter your current password in the Password field.

Enter a new username in the Username field.

Click Apply.

v &weN

The View Properties page appears displaying your new username. The new name also
appears on the navigation bar.

Viewing your usage quotas

Your administrator can restrict the number of documents that you own as well as the maximum
size allocated to all of your documents. You can view your quotas and your current usage.

Note: Documents include email attachments and documents attached to discussion topics
and wiki pages.

To view your usage quotas:
1. On the navigation bar, click your username.

2. Onthe View Properties page, click the Quotas link.
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If set, the page displays your quotas

Note: When Not set (default to highest group setting) is used, DocuShare checks the
quotas assigned to all the groups you are a member of and uses the highest. If none
of the groups have quotas set, then your quotas default to unlimited.

3. Toview your current usage, click the Show Quota Usage button.

The meters display your current usage information.

Should you exceed your usage quotas, you will receive an error message when you try to add
another document to your site. Contact your administrator should this occur.

Changing your domain

If your site uses domains, you can change to another internal domain on DocuShare. You must be
logged in as the user whose domain you want to change. You cannot change another user’s
domain.

To change your current domain:

1. On the navigation bar, click your username.

On the View Properties page, click the Change Domain link.

Select a new domain from the Domain menu.

Click Apply.

& W N

Selecting a theme

Themes let you personalize the look of your DocuShare site. Four predefined themes are provided;
each changes the color scheme used on site pages.

To select a theme:
1. On the navigation bar, click your username.
2. Onthe View Properties page, click the Themes link.

3.  Select a theme.

Note: If you choose to not use a theme, the default theme is used.

4, Click Apply.

Viewing your activity history

DocuShare keeps track of all user activity on your site, which provides an audit trail of the actions
of each user. You can view your site activity only. An administrator can view the activity of all site
users.

Your administrator determines whether or not the activity history feature is enabled on your site.

Xerox® DocuShare® User Guide 18
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To view activity history:

1.

5 wN

Click your username on the navigation bar.
On the View Properties page, click the Activity History link.
From the Activity menu, select the type of activity you want to view.

From the Object Type menu, select an object to limit the activity displayed to a specific
object type.

From the Show Last menu, select the number of activity events to display.
To display the activity during a specific date range, enter start and end dates.
Click Go.

Information about the activity displays. You can click Show as XML to convert the
information to Extensible Markup Language (XML) format for use with other applications.

Changing federation settings

DocuShare federation enables you to search multiple DocuShare sites to easily access content
located on several servers. If your site is a member of a DocuShare federation (a Federation icon
appears at the bottom of a DocuShare page), you must map your user account information to the
other member servers that you want to access.

To map your user account:

1.
2.

On the navigation bar, click your username.

On the View Properties page, click the Federation Settings link.

The Federation Settings page lists the servers in your federation.

Click the Edit Mapping link that appears to the right of the server to which you want to map.

The Edit Mapping page appears. If you know your username on the server, continue with
step 4. To search for your username, go to step 5.

Note: If you do not have an account on the server, see the procedure Create a user
account on a federated server below.

To enter your account information, click Enter manually and do the following:

a. Enter your username, password, and domain (if applicable).

b.  Click Apply.

Your username appears on the Federation Settings page.

To select your user account from a list, click Choose from list and do the following:
a. Find your account by doing one of the following:

e  Enter part of your first name, last name, or username in the Search field and click
the Go button.

o Ifdisplayed, click Show All to list all user accounts.

e  C(lick Show users with my email address to display the accounts with your email
address.

b.  Select your account.
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c.  Enter the password for the account.
d. Click Apply.

Your username appears on the Federation Settings page.

Create a user account on a federated server
1. Onthe Edit Mapping page, click the Create a new user account on this server link.

The Add User page on the server on which you are creating the account appears.
Note: If the site does not allow guest access, you cannot create an account.

2. Enter your account information and click Apply.

3. Click the browser’s Back button until you return to the Edit Mapping page on the initial
server.

Click Choose from list.
Display your account and select it.

Enter your password.

N oo v B

Click Apply.

Your username appears on the Federation Settings page.

Remove an account mapping

1. On the navigation bar, click your username.

2. Onthe View Properties page, click the Federation Settings link.
The Federation Settings page lists the servers in your federation.

3. Click the Edit Mapping link that appears to the right of the server whose mapping you want
to remove.

4. On the Edit Mapping page, click No user mapping.
5. Click Apply.

Your username does not appear next to the server on the Federation Settings page.

Deleting a user account

Only an administrator can delete an existing user account. Contact your administrator if you want
to delete your user account. If you have several user accounts, your administrator can combine
any number of the accounts into one account.

Group accounts

A group consists of any number of DocuShare users, groups, or both. When your site includes
groups, you can more easily manage access to objects by assigning permissions to the group
instead of to each user.
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Creating a group

The DocuShare administrator can choose to allow logged-in users to create group accounts or to
have group account creation under administrative control. If after logging into DocuShare, you do
not see the Add Group link on the Users and Groups Registry page, then an administrator will
need to create a group for you.

To create a group:

1. Onthe page footer, click Users & Groups.

2. Click the Add Group link.

3. IntheTitle field, enter a name for the group. The name can contain spaces and punctuation
marks, and can be identical to another group name.

4. Inthe Domain field, select the name of a domain. The menu lists internal domains only.

5. Inthe Spam Control field, select either No Restriction, Registered Users Only or Group
Members Only.

6.  Enter any optional information. Click a field name for a description of each property.

Note: If your administrator created custom properties, they also display on the page.
See your administrator for information about custom properties.

7. Click Apply.
The Pick Members for Group page appears.

8. Inthe Show field, select the type of account you want to display in the Possible
Users/Groups field.

9. Do one of the following:

— Tofind a specific account, enter part of the user’s first name, last name, or username or
the group’s title in the Search field. Click the Go button.

—  Tolist all accounts, click Show All (if displayed).
—  Todisplay your favorite accounts, click Show Favorites.

10. Inthe Possible Users/Groups field, select the accounts to add to the group and click the
Add button. To select multiple accounts, use the Ctrl key (Windows) or the Command key
(Macintosh).

11.  Inthe Selected Users/Groups field, select any accounts that you want to remove from the
group and click the Remove button. To select multiple accounts, use the Ctrl key (Windows)
or the Command key (Macintosh).

12. Click Update.
The group members display on the Members page.

13. To give one or more members manage permission to the group, click the checkbox next to
each member’s name and click Apply. Manage permission allows the member to change the
group’s properties and membership.
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Viewing group properties
You can view the properties of any DocuShare group.

To view a group’s properties:

1. Locate and select the group whose properties you want to view. To search for a group, see
Finding and listing site accounts on page 25.

The View Properties page for the group appears. Click a field name for a description of each
property.

Changing group properties

Depending on how the group was set up, either the logged-in owner of the group or a logged-in
group member can change the properties of a group.

To change a group’s properties:

1. Locate and select the group whose properties you want to change. To search for a group, see
Finding and listing site accounts on page 25.

2. Onthe View Properties page, click the Edit link.
3. Change the properties that you want. Click a field name for a description of each property.

4, Click Apply.

Viewing the usage quotas for a group

Your administrator can restrict the number of documents that each group member can own as
well as the maximum size allocated to all of the documents. You can view the quotas assigned to a

group.

Note: Documents include email attachments and documents attached to discussion topics
and wiki pages.

To view the usage quotas for a group:

1. Locate and select the group whose usage quotas you want to view. To search for a group, see
Finding and listing site accounts on page 25.

2. Onthe View Properties page, click the Quotas link.
If set, the page displays the quotas.

Note: Any quotas set for a user take precedence over the quotas set for a group the
user is a member of.

Changing the members of a group

Depending on how the group was set up, either the logged-in owner of the group or a logged-in
group member can change the members of the group.
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To change a group’s members:

1.

Locate and select the group whose members you want to change. To search for a group, see
Finding and listing site accounts on page 25.

On the View Properties page, click the Members link.
The Members page shows the current group members.
To change group members, click the Change Membership button.

In the Show field, select the type of account you want to display in the Possible
Users/Groups field.

Do one of the following:

— Tofind a specific account, enter part of the user’s first name, last name, or username or
the group’s title in the Search field. Click the Go button.

—  Tolist all accounts, click Show All (if displayed).
—  Todisplay your favorite accounts, click Show Favorites.

In the Possible Users/Groups field, select the accounts to add to the group and click the
Add button. To select multiple accounts, use the Ctrl key (Windows) or the Command key
(Macintosh).

In the Selected Users/Groups field, select any accounts that you want to remove from the
group and click the Remove button. To select multiple accounts, use the Ctrl key (Windows)
or the Command key (Macintosh).

Click Update.

The group members display on the Members page.

Changing the owner of a group

Only the logged-in owner of the group can change its owner. After changing the group’s owner to
another user, you will no longer be able to change the group’s members and properties, unless you
have manage permission to the group.

To change the owner of a group:

1.

Locate and select the group whose owner you want to change. To search for a group, see
Finding and listing site accounts on page 25.

On the View Properties page, click the Edit link.
Click Change Owner.

The Change Owner page appears.

Do one of the following:

—  Tofind a specific user account, enter part of the user’s first name, last name, or
username in the Search field. Click the Go button.

— Tolist all user accounts, click Show All (if displayed).
—  Todisplay your favorite accounts, click Show Favorites.

Select a name from the New Owner field.
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6. Inthe Add Owner to Group field, click Yes to add the new owner to the group.
7.  Click Update Owner.

Changing the domain of a group

If your site uses domains, you can change a group’s domain to another internal domain on
DocuShare. You must be the logged-in owner of the group to change its domain.

Note: Changing the group’s domain does not change a group member’s domain, if one is
used.
To change a group’s domain:

1. Locate and select the group whose domain you want to change. To search for a group, see
Finding and listing site accounts on page 25.

2. Onthe View Properties page, click the Change Domain link.
3. Select a new domain from the Domain menu.

4. Click Apply.

Sending mail to group members

To easily communicate with a DocuShare group, you can send an email message to the group’s
members. The message is sent to each member whose user properties include an email address.
To send email, your web browser must be correctly configured with a mail client, such as Microsoft
Outlook.

To send email to the members of a group:

1. Locate and select the group that you want to send an email message to. To search for a
group, see Finding and listing site accounts on page 25.

2. Onthe View Properties page, click the Email link.
3. To write your message, click the here link.

Your browser launches an untitled message window with each group member's email
address entered in the To field.

4. Compose your message and click Send to email the message to the members of the group.

Viewing the change history

DocuShare keeps track of all the changes to site objects, which provides an audit trail of the
changes to objects.

To view the change history:

1. Locate and select the group whose change history you want to view. To search for a group,
see Finding and listing site accounts on page 25.

2. Onthe View Properties page, click the Change History link.

3. From the Change menu, select the type of change you want to view.
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4. Do one of the following:

—  Enter part of a name in the Search for User field and then choose the user from the
Select User menu.

— If displayed, click Show All and then choose the user from the Select User menu.
—  Choose All from the Select User menu.

5. From the Show Last menu, select the number of change events to display.

6.  Todisplay the activity during a specific date range, enter start and end dates.

7. Click Go.

Information about the change displays. You can click Show as XML to convert the
information to Extensible Markup Language (XML) format for use with other applications.

Deleting a group
You can delete a group if you are the logged-in owner of the group.

To delete a group:

1. Locate and select the group that you want to delete. To search for a group, see Finding and
listing site accounts on page 25.

2. Onthe View Properties page, click the Delete Group link.
The Confirm Delete page appears.

3. Click Delete to remove the group from your site.

Finding and listing site accounts

From the User and Group List page, you can quickly search the users and groups registry to
determine whether or not a user or group has an account on the DocuShare site. You also can list
all of the user and group accounts registered on the site.

To search for a user or group:

1. Onthe page footer, click Users & Groups.

2. Onthe User and Group List page, select the type of account you want to find in the Show
field.

3. Whensearching for a user, you can filter the results by selecting a single user level or all levels
from the User Level menu. You can also filter by active or inactive status and domain.

4. Inthe Search field, enter any part of a username or group title.
5. Click Go.

The search results display, listing the users, groups, or both who match the search text and
the filters you set.
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To list the accounts on your site:

1. Onthe User and Group List page, select the type of account you want to list in the Show
field.

2. Click Show All (if displayed).
The list of all registered accounts displays.
When displaying the list of accounts as a CPX user, the User and Group List page enables you to

see which users are logged into DocuShare. The user icon next to the user's name indicates
whether or not the user is logged in; the icon is grayed when the user is not logged in.
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About DocuShare objects

You create content on your site by adding different types of DocuShare objects. You organize site
content in container objects called collections. Using the CPX feature, you manage the content
and resources associated with projects in objects called workspaces. Objects that you can add to
collections and workspaces include: documents, collections, calendars, discussions, weblogs, wikis,

and URLs.

DocuShare identifies each object on your site with a unique handle (for example, Document-37
and Calendar-102). The type and number of objects on your site are dependent on your
organization’s needs.

Each DocuShare object is indicated by an icon.

DocuShare icons

DocuShare object and its icon

User—A registered DocuShare user.

Joly

Group—One or more DocuShare
users, groups, or both.

8
&

Collection—A container for storing
DocuShare objects.

O

Document—A document stored on
the DocuShare site. The icon can vary,
depending on the document’s file

type.

Document Storage Workspace—A
collaborative workspace for a
document-intensive project.

Team Project Workspace—A
collaborative workspace for a team
project. It includes a calendar and a
collection for online meeting URLs.

<

Wiki—A collaborative web site.

Weblog—A simple web site for
frequent postings.

Discussion—An online forum where
topics can be posted.

Topic—A posting to a discussion.

Calendar—An online monthly or
weekly calendar.

Event—A calendar entry.
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DocuShare icons

DocuShare object and its icon

Mail Message—An email message. Saved Query—Saved search query
E .~ |  terms that can be used for a search.
Notification—.Email notification Content Rule—A configurable rule

& after a change occurs to a specified “5%  for running an action after a change
object. {:‘;} occurs to a specified object.

URL—AnN Internet address for a web

C) page.

Object permissions

Every DocuShare object has an access list, which identifies the users and groups who have
permissions to the object and the type of permission each account has. The type of permission
controls what a user can do with the object.

Depending on how your administrator set up your site, either three or six permissions are available
for use. In addition, you can control who can see an object in a search results list. The table below
provides a description of each permission.

Permissions
Three Permissions Six Permissions
Reader allows the user or group to read the Read Properties allows the user or group to view
content of the object and view its associated the object’s properties and permissions.

properties and permissions.

Writer allows the user or group to change the Read Content allows the user or group to read
object’s properties and add new objects, including | the content of the object.
new versions of documents.

Manager allows the user or group to delete the Read History allows the user or group to view the
object, and change the object’s permissions and object’s change history.
owner.

Write Properties allows the user or group to
change the object’s properties.

Write Content allows the user or group to add
new objects, including new versions of
documents, and change the object, such as its
location.

Manage allows the user or group to delete the
object, and change the object’s permissions and
owner.

Task Permissions on page 105 details the type of permission required for each object task.
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Adding objects

You can add an object to your site if you are logged in and have the required permission to the
container. You can add any type of object to collections and workspaces. You can add events to
calendars and topics to discussions.
To add an object:
1. Navigate to and open the container to which you want to add an object.
2. From the Add menu, select the type of object that you want to add.

The Add page appears.

3. IntheTitle field, enter a name for the object. The name should be short, but descriptive, and
can contain spaces and punctuation marks.

4. Enter any additional required information as well as optional information. Click a field name
for a description of each property.

Note: If your administrator created custom properties, they also display on the page.
See your administrator for information about custom properties.

5. Click Apply.
The object is added to the container.

For more information on adding documents, see Adding a document on page 39. For more
information on adding discussions, weblogs, and wikis, see Using social computing features
on page 67.

Selecting the objects that appear in the Add menu

You can control what type of objects users can add to your collections by adding or removing
items from the Add menu.

To modify the Add menu:
1. Navigate to the collection that you want to change.
Click the collection’s Properties icon.

On the View Properties page, click the Add Menu Objects link.

5 wenN

On the Add Menu Objects page there will be a list of the possible objects that can appear in
the Add menu. Select the ones that you want to appear in the Add menu. To select multiple
accounts, use the Ctrl key (Windows) or the Command key (Macintosh).

5. Click Apply.

6.  Navigate back to your collection listing and click the Add menu. Only the objects you
selected appear in the menu.
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Viewing objects in containers

When viewing objects in a collection or events in a calendar, you can change how the objects are
displayed in the container. In addition, you can control the number of objects to display per page.
You can display a collection in any of the following views:

o List view—Displays objects in a list.

o Images view—Displays image files as thumbnails and all other object types as large icons.

. Email view—Displays the properties associated with email messages.

You can display a calendar in any of the following views:

. Month view—Use the 31 button to display an entire month with the current day
highlighted. From the current month, you can click a link for the previous month and the next
month. You can also display calendars for previous and following years.

The start time and title of each calendar event is shown on the date to which it was added.

o Week view—Use the 7 button to display an entire week with the current day highlighted.
From the current week, you can click a link for the previous week and the next week. You can
also display calendars for previous and following years.

The duration, title, and owner of each event is shown on the date to which it was added.

. Day view—Use the 1 button to display the current day. From the current day, you can click
a link for the previous day and the next day. You can also display a day from another month
or year.

The day view shows the duration, title, and owner of each event added to the date.

To set the number of objects to display per page:
1. On the navigation bar, click your username.
2. Onthe View Properties page, click the Edit link.

3. Inthe Page Size field, enter the number of objects you want to view on pages with object
listings (for example, collections and search results).

4. Click Apply.

Viewing and changing object properties

Every object has a set of assigned properties. For example, the properties for all objects include a
title, a description, and an owner. Each object has a number of specific properties. For example,
the sort order property is unique to collections and documents have a maximum versions
property. Your DocuShare administrator also can create custom properties for use at your site. You
can assign property values to objects, which allows you to categorize objects, provide information
about objects to other users, and facilitate searches.

To view and change the properties of an object:

1. Locate the object whose properties you want to view and change.
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2. Click the object’s Properties icon.
3. Onthe View Properties page, click the Edit link.

4. Change the properties you want. Click a field name for a description of each property.

Note: If your administrator created custom properties, they also display on the page.
See your administrator for information about custom properties.

5. Click Apply.

Viewing the change history

DocuShare keeps track of all the changes to site objects, which provides an audit trail of the
changes to objects. Your administrator determines whether or not the change history feature is
enabled on your site.

To view the change history:

1. Locate the object whose change history you want to view.

Click the object’s Properties icon.

On the View Properties page, click the Change History link.

From the Change menu, select the type of change you want to view.

v B W N

To filter the change history results, do one of the following:

—  Toview the changes a particular user made, enter part of the user’s name in the Search
for User field and then choose the user from the Select User menu.

—  Click Show All (if displayed) and then choose the user from the Select User menu.
—  Choose All from the Select User menu.

6.  From the Show Last menu, select the number of change events to display.

7. Todisplay the activity during a specific date range, enter start and end dates.

8.  Click Go.

Information about the change displays. You can click Show as XML to convert the
information to Extensible Markup Language (XML) format for use with other applications.

Generating object reports

From a collection listing or a Search Results page, you can generate an object report by exporting
DocuShare property information. Your administrator determines which properties display in the
report. The generated report is in tab-separated values format, which enables you to open the
report in a spreadsheet application.

To generate an object report from a collection listing:

1. Open the collection that contains the objects that you want detailed in the report.

2. Toselect individual objects, click the checkbox next to each object.
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Note: Do not click any checkboxes if you want all of the objects in the report.

3. From the Edit Selected menu, select Generate Report.

4. Inthe file download window, choose the option to save the report.

To generate a object report from a Search Results page:
1. Runasearch to find the objects that you want in the report.

2. Toselect individual objects, click the checkbox next to each object.

Note: You can click the checkbox to the left of the Type column heading to select all of
the objects. If there are multiple search pages, select Show All from the Show menu
first.

3. From the Edit Selected menu, select Generate Report.

4. Inthe file download window, choose the option to save the report.

Managing access to objects

When you add an object to your site, you set the object’s initial permissions. As the user who
added the object, you are its owner and have full permission to it. As needed, you can change the
users and groups in the access list and the type of permissions each user or group has.

Depending on how your administrator set up your site and if you are a CPX user, colored key icons
may appear next to objects indicating who can access the objects. You can click the key icon next
to an object to display its Permissions page.

Permission icons

Permission icon and its description

P Green key—Indicates that the object can be accessed by anyone.

Yellow key—Indicates that the object can be accessed by one or more groups.

Gray key—Indicates that the object can be accessed by individual users.

Viewing the access list of an object

To view an object’s access list:
1. Locate the object whose access list you want to view.
2. From the object’s More Actions menu, select Permissions.

The Permissions page displays the users and groups in the access list and the permissions
each account is assigned.
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Changing the access list of an object

To change an object’s access list:
1. Locate the object whose access list you want to change.
2. Do one of the following:
—  From the object’s More Actions menu, select Permissions.
— If displayed, click the key icon that appears to the right of the object’s title.
The Permissions page for the object appears.
3. For Search Available To, do one of the following:
—  Click Anyone to allow guests and users to view the object in a search results list.

—  Click Access List Only to allow only those accounts in the object’s access list that have
at least Reader or Read Properties permission to see the object in a search results list.

4. If you want to change the list of users and groups who have access to the object, click the
Change Access List button.

The Change Access List page appears.

5. Inthe Show field, select the type of account you want to display in the Possible
Users/Groups field.

6. Do one of the following:

— Tofind a specific account, enter part of the user’s first name, last name, or username or
the group’s title in the Search field. Click the Go button.

—  Tolist all accounts, click Show All (if displayed).
—  Todisplay your favorite accounts, click Show Favorites.

7. Inthe Possible Users/Groups field, select the accounts to add to the access list and click the
Add button. To select multiple accounts, use the Ctrl key (Windows) or the Command key
(Macintosh).

8. Inthe Selected Users/Groups field, select any accounts that you want to remove from the
access list and click the Remove button. To select multiple accounts, use the Ctrl key
(Windows) or the Command key (Macintosh).

9. Click Update Access List.
The Permissions page appears, displaying the new access list.

10. Check the permission boxes you want for each user and group displayed in the access list.

11.  Click Apply.

Note: When you change the access list and permissions of an object, the change occurs in
the background. A link to your background jobs appears under the navigation bar; you can
click the link to check the status of and delete background jobs.

Changing the owner of an object

The default owner of an object is the user who initially created the object.
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To change the owner of an object:
1. Locate the object whose owner you want to change.
2. Do one of the following:

—  Click the checkbox that appears to the left of the object’s title. From the Edit Selected
menu, select Change Owner. On the confirmation page, click Confirm.

—  From the object’s More Actions menu, select Permissions. On the Permissions page,
click the Change Owner button.

The Change Owner page appears.
3. Do one of the following:

— Tofind a specific user account, enter part of the user’s first name, last name, or
username in the Search field. Click the Go button.

—  Tolist all accounts, click Show All (if displayed).
—  Todisplay your favorite user accounts, click Show Favorites.
4. Select a username from the New Owner field.

5. If the object is a document, see Applying permissions to a document and its versions on
page 35.

6. If the object is a collection, see Applying permissions to the objects in a container on
page 34.

7.  Click Update Owner.

The Permissions page for the object appears, displaying the name of the new owner at the
top of the access list. The new owner has full permissions.

The name of the previous owner remains in the access list.

Applying permissions to the objects in a container

When you change the permissions of a container that includes objects, you can choose how to
apply the container’s permissions to its contents. You can choose to apply all of the permissions or
only the changed permissions to either the container or the container and its contents.
To apply a container’s permissions to the objects in it:
1. Locate the container whose permissions you want to change.
2. From the container's More Actions menu, select Permissions.
The Permissions page for the container appears.
3. Make the changes you want to the access list.
4. For Options, select one of the following:
—  Apply all permissions to—Assigns all of the access permissions.
—  Apply only changes to—Assigns only the changed access permissions.
5. Select one of the following:

—  This container only—Applies the permissions to the container only. The permissions
of the container’s objects are not changed.
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—  This container and its objects, including objects that appear in multiple
locations—Applies the permissions to the container and the objects in it. The
permissions of the same objects that appear in other containers also are changed.

—  This container and its objects, excluding objects that appear in multiple
locations.—Applies the permissions to the container and the objects in it. The
permissions of the same objects that appear in other containers are not changed.

6.  Click Apply.

Applying permissions to a document and its versions

Each version of a document has its own access list. Therefore, when you change a document’s
permissions you can choose how you want to apply the changes to the document’s versions.
To apply a document’s permissions to its versions:
1. Locate the document whose permissions you want to change.
2. From the document’s More Actions menu, select Permissions.
The Permissions page for the document appears.
3. Make the changes you want to the access list.
4. For Apply all permissions to, select one of the following:

—  This document and its versions—Assigns the changed permissions to the document
and all of its versions.

—  This document only—Assigns the changed permissions to the document only. The
document and its versions will have different access permissions.

5. Click Apply.

Changing the location of objects

You can move an object to another container or have the object appear in several containers on
your site. Although an object can appear in several containers, there is only one copy of it, which
saves space on your DocuShare site.

Note: You can also use the Copy, Cut, and Paste commands from the Edit Selected menu to
change the location of a collection. See Using Copy, Cut, and Paste to change the location
of an object on page 36.

To change the location of an object:

1. Locate the object whose location you want to change.

2. Do one of the following:

—  Click the checkbox that appears next to the object’s title. From the Edit Selected menu,
select Change Location. On the Confirm Change Location page, click Confirm.

—  Click the Properties icon that appears to the right of the object’s title. On the Properties
page for the object, click the Locations link.
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The Change Location page appears.

In the Sort By field, select Title to display the possible containers in alphabetical order or
select Handle to display the possible containers in numerical order.

Do one of the following:

—  To find specific containers, enter any part of a container title in the Search field. Click
the Go button.

—  Tolist all containers, click Show All (if displayed).
—  Todisplay your favorite containers, click Show Favorites.

In the Possible Locations field, select the containers in which you want the object to appear
and click the Add button. To select multiple containers, use the Ctrl key (Windows) or the
Command key (Macintosh).

In the Selected Locations field, select any containers in which you do not want the object
to appear and click the Remove button. To select multiple containers, use the Ctrl key
(Windows) or the Command key (Macintosh).

Note: Make sure at least one container appeatrs in the Selected Locations field.
Otherwise, the object will become orphaned, which means it will not appear in any
container.

Click Update Locations.

Using Copy, Cut, and Paste to change the location of an object

To copy or cut objects:

1.
2.
3.

Locate the object that you want to copy or cut.

Click the checkbox next to the object.

From the Edit Selected menu, select either Copy or Cut.

A confirm window appears.

Choose whether or not to remove any objects from the clipboard before the copy or cut.

Click Confirm.

Note: When using the Cut command, the object title is faint until you Paste it to
another container.

Open the container in which you want to paste the object.

Note: To paste a workspace, open the workspace in which you want to paste the
object and then click Content Map.

From the Edit Selected menu, select Paste.

A confirm window appears.

Choose whether or not to remove any objects from the clipboard after the paste.
Click Confirm.

The object appears in the container.
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Editing multiple objects in a collection

When viewing an open collection, you can use the Edit Selected menu to perform a variety of
tasks on one or more objects. The menu includes these commands:

Add to Favorites—Add the object to Favorites on My DocuShare.

Archive and Restore—Move the object to and retrieve the object from an Archive Server
(commands appear if your site uses an Archive Server). See Archiving content on page 102
for more information.

Change Location—Add the object to another location.
Change Owner—Change the owner of the object.

Copy—Copy a reference of the object to the clipboard. You have the option of clearing the
objects on the clipboard before you copy your selected objects. The clipboard can contain a
maximum of 100 objects.

Copy Shortcuts—Copy a reference of the object to the clipboard so it can be pasted to a
shortcuts portlet on a workspace. You have the option of clearing the objects on the
clipboard before you copy your selected objects.

Cut—Cut the object to the clipboard. You have the option of clearing the objects on the
clipboard before you cut your selected objects. The clipboard can contain a maximum of
100 objects.

Paste—Paste the object from the clipboard (command appears when an object has been
copied or cut to the clipboard).

Delete—Remove the object from your site.
Rename—Change the title of the object.

Route—Send the document to users for approval, review, or information. See Automating
work processes on page 77 for more information.

Generate Report— Exports DocuShare property information to a report. See Generating
object reports on page 31.

Zip and Download—Download documents and collections by first zipping them.

To edit multiple collection objects:

1.
2.

Navigate to and open the collection.

Do one of the following:

— To edit some of the objects, click the checkbox next to the objects you want.

—  To edit all of the objects, click the checkbox to the left of the Type column heading.
From the Edit Selected menu, select the command you want.

A confirm window appears.

Click Confirm to continue. Depending on which command you selected, additional pages
may appear.

Note: When using the Change Location command, if an object appears in more than one
collection, only the current collection is listed in the Selected Locations field.
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Deleting objects

DocuShare provides both a site-wide trashcan and a personal trashcan for each user. Your
administrator determines which trashcans are used on your site. If your site uses both the site-
wide trashcan and personal trashcans, your trashcan appears on your My DocuShare page. When
you delete an object, it goes to your personal trashcan. You can restore and expunge an object
from your personal trashcan as long as your administrator has not expunged the object from the
site-wide trashcan. See Using your personal home page on page 98 for more information.

If your site uses the site-wide trashcan only, then objects you delete go to it. To restore an object
from the site-wide trashcan, you need to contact your administrator. If trashcans are not used on
your site, deleted objects are expunged immediately.

To delete an object:

1.
2.

Locate the object that you want to delete.
Do one of the following:

—  Click the checkbox that appears next to the object’s title. From the Edit Selected menu,
select Delete.

—  From the object’s More Actions menu, select Delete.

The Confirm Delete page appears.

Note: If a minus sign appears in the checkbox that precedes the object, then you do
not have manage permission to the object and cannot delete it.

If you are deleting a collection, select one of the following from the For collections, delete
menu:

—  Collection and Contents to delete the collection and all of the objects in it.

—  Collection Only to delete the collection, but not its contents.

Note: If you delete a collection, but not its contents, and the objects are not located in
another collection, they become orphaned. You are unable to access orphaned objects
from a collection. Your administrator can relocate orphaned objects in a collection so
you can access them again.

Click Delete to remove the object from your site.
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About documents

Using DocuShare, you can store, access, and manage documents created in a variety of popular
formats. You add documents to DocuShare by uploading documents from your computer or a
network drive or by scanning paper documents. With the documents stored on DocuShare, users
connected to the network can use their browser to search for, view, edit, and download a
document.

For document management, DocuShare supports version control and document locking. By
default, DocuShare saves four versions of a document; you can change the number of versions
DocuShare saves on a per-document basis. In addition, you can change a document’s preferred
version, which is the version that opens when users view, edit, and route the document. By default,
a document’s preferred version is its latest version.

Adding a document

You add a document to a collection or workspace to make it available to others for viewing or
collaborative work. There are several ways to add documents.

Adding documents using the Add menu

Using the Add menu, you can upload a document and make it available immediately, or you can
create a placeholder for a document and add it later.
To add a document using the Add menu:
1. Navigate to and open the container to which you want to add the document.
2. From the Add menu, select Document.
The Add Document page appears.
3. Inthe Add Document By field, select one of the following:
— Uploading a document now to upload a document immediately.

—  Scanning a document using a cover sheet to scan a paper document. This option
appears if scanning is set up on your site. This will cause a placeholder document to be
added. The placeholder does not contain any content; you add content to the
placeholder by scanning a document using a cover sheet.
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— Uploading a document later to upload a document at a later time. This will cause a
placeholder document to be added. The placeholder does not contain any content; you
add content to the placeholder by uploading a new version.

4. If you are uploading a document now, click the Choose File button to navigate to the
document and select it.

5. Enter the following information:
Title—The title of the document. The title can contain spaces and punctuation marks.

Max Versions—The maximum number of versions to save. Once the maximum number of
versions is reached, when a new version of a document is saved to DocuShare, the oldest
version is deleted, unless it is the preferred version.

6.  Enter any optional information. Click a field name for a description of each property.

7. Click Apply.

If you are uploading a document, it is added to the container. If you are scanning a
document, a cover sheet appears. Print the cover sheet. For information on how to use the
cover sheet, see Scanning a document with a scan cover sheet on page 48. If you are
uploading a document later, you can add the document content by adding a new version.
See Uploading a new version of a document on page 43.

If you chose to route the document, a Routing Slip appears. For information on how to use
the Routing Slip, see Managing access to objects on page 32.

Adding documents using drag and drop

You can also add documents by dragging and dropping them into a collection. There are two
options available when using this method: upload instantly or fill in properties and then upload.

To add a document using drag and drop:

—_

Navigate to and open the collection to which you want to add the document.
Using your file manager, locate the document you want to add to DocuShare.

Click the document in your file manager and drag it to the collection.

5w N

Do one of the following:

— If youwould like to add the documents quickly and enter the file information later, drop
the document onto the rectangle labeled Drop files here to instantly upload them as
Documents. The document will be uploaded. The filename will appear as the title of
the document.

—  If youwould like to add the document and add properties such as Title, Author and the
Max Versions, drop the document onto the rectangle labeled Drop files here to select
a type and fill details before uploading.

Note: With either method, you can add several files at once. Use the Ctrl key and drag and
drop the group of files to either rectangle.
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Viewing a document

To view a document, you either open the document directly in the browser or first download it and
then open it. Downloading the document copies it and keeps the original document on
DocuShare.

Your browser controls how a document is displayed. By design, browsers are able to handle several
types of documents and files, such as HTML, GIF, and JPEG. However, different browsers behave
differently. For some documents, such as Microsoft Word and Excel, your browser may launch a
helper application (viewer) to run or display the document either outside or within the browser
window. To play some multimedia files, the browser uses a plug-in, which opens the file within the
browser window.

Your browser is preconfigured to use specific helper applications and plug-ins. Generally, if you try
to open a document or file that your browser does not recognize, it displays a window that guides
you in finding the application to use for that type of file.

To view a document:

1.  Locate the document that you want to view.

2. Click the document’s title. At this point, depending on your browser:
—  The document will open.
— A window will appear allowing you to view the document.

— A window will appear allowing you to download the document. Once it has
downloaded, you will need to open it.

3. Toreturn to the container page after opening the document, do one of the following:
—  If the document opened in a separate window, select Exit from the File menu.
—  If the document opened within the browser window, click the browser’s Back button.

Note: If you click the X in the top-right corner of the browser or select Close from the File
menu, your browser closes and you lose your connection to the DocuShare site.

Viewing a document and its properties

For PDF documents, a variety of image documents (GIF, JPEG, PNG, TIFF), and other document
formats, you can view the document content while viewing and editing the document’s properties.

Note: To view Microsoft Word and PowerPoint documents, you should use Internet Explorer.
Also, make sure your Folder Options are configured to open each document type within the
same browser window.
To view a document and its properties:
1. Locate the document that you want to view.
2. From the document’s More Actions menu, select View Document & Properties.

Both the document and its properties display in a separate window.

3. Change any of the properties and click Update.
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4. Click Close to close the window.

Viewing an HTML rendition of a document

DocuShare provides an HTML conversion feature that lets you view supported document types in
HTML format. This feature eliminates the need to configure your browser to display certain
document types.

Note: The HTML conversion feature cannot convert documents that contain encrypted
information.
To view an HTML rendition of a document:
1. Locate the document that you want to view.
2. From the document’s More Actions menu, select View in HTML.
DocuShare converts the document to HTML and displays the document.

3. Click the browser’s Back button to return to the container page.

Viewing a PDF rendition of a document

DocuShare provides a PDF conversion feature that lets you view supported document types in PDF
format. This feature eliminates the need to configure your browser to display certain document

types.

Note: The PDF conversion feature cannot convert documents that contain encrypted
information. You must have Adobe® Reader® installed on your computer.

To view a PDF rendition of a document:
1. Locate the document that you want to view.
2. Fromthe document’s More Actions menu, select View in PDF.

DocuShare converts the document to PDF and displays the document.

Adding a new document version

There are two ways to add a new document version:

o Check out and edit an existing document, and check in the revised document as a new
version.

. Upload a document as a new version of an existing document.

Editing a document

DocuShare supports the complete development cycle of a document, allowing users to collaborate
on a project. Document check out and locking ensures that only one user at a time edits a
document. Version control maintains a user-specified number of document versions.
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To edit a document and create a new version, you must be either the logged-in owner of the
document or a logged-in user with the appropriate permission to it. In addition, the DocuShare
administrator must have set the Add Versions property to Allowed.

Note: If a DocuShare desktop client is installed on your computer and you enabled the
Handle checkout from web browser (or Internet Explorer) property, the DocuShare Checkin
Wizard displays after you edit and save the document. When using this feature, make sure
DocuShare’s URL in the browser is the same as the server’s address in the DocuShare
desktop client. To check the server’s address, right-click the server name and select
Properties.
To edit a document:
1. Locate the document that you want to edit.
2. Click the document’s Check Out icon.

A window appears allowing you to open or download the document.
3. Edit the document.

4. Do one of the following:

—  If the document opened in the browser, click the Back button. Click Yes to save your
edits.

—  If the document opened in its native editor, select Save As from the File menu.
5. Inthe Save As window, save the document to a location on your local drive.

Do not change the name of the document.
6.  Onthe container page, click the document’s Upload a New Version icon.

The Add Version page appears.
7. Click the Browse button.

8.  Navigate to the location on your local drive in which you saved the edited document, select
it, and click Open.

The path to the document appears in the Filename field.

9. Inthe Title field, you can change the version title. By default, the new version is assigned the
original document title.

10. Optionally, enter any comments in the Version Comments field.

11.  If you locked the document, choose whether or not you want to unlock the document after
adding the new version in the Unlock Document field.

12.  When a document version other than the latest is the preferred version, you can click Yes in
the Make This The Preferred Version field to set this version as the preferred one.
Otherwise, click No to not change the preferred version.

13.  Click Apply.

Uploading a new version of a document

You can add a new version of a document by uploading a document from a folder on your local
drive or a network drive.
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To add a new version of a document:

1. Locate the document that you want to update with a new version.

2. From the document’s More Actions menu, select Upload a New Version.
The Add Version page appears.

3. Click the Choose File button.

4. Navigate to the location that contains the document you want to add as a new version,
select it, and click Open.

5. Inthe Title field, you can change the document title. By default, the new version is assigned
the original document title.

6.  Optionally, enter any comments in the Version Comments field.

7. If the previous version of the document was locked, the Unlock Document field appears.
Click No if you do not want to unlock the document after adding the new version.

8.  Click Apply.

Managing document versions

DocuShare’s version control feature enables you to maintain a record of a document's history. For
each version DocuShare saves, you can view the content, the date and time the version was
added, the user who added the version, and any user-provided comment. You can also view and
edit each version’s properties and permissions, and route individual versions.

By default, DocuShare saves four versions of a document. You can change the default setting by
changing the document's Max Versions property.

Viewing document versions

To view a document’s version history:
1. Locate the document whose version history you want to view.
2. Click the document’s Properties icon.
The View Properties page appears.
3. Click the Version History link.
The page displays all saved versions of the document.
4. Toview a specific version of the document, click its type or version number.
5. Toreturn to the Version History page, do one of the following:
—  If the document opened in a separate window, select Exit from the File menu.

—  If the document opened within the browser window, click the browser’s Back button.
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Changing the preferred version

By default, a document’s preferred version is the latest version. When there is more than one
version of a document, you can change the document’s preferred version. This is the version of the
document that opens when users view, edit, and route the document. However, users can route a
specific document version from the document’s Version History page.

DocuShare always saves the preferred version, regardless of the number of Max Versions
specified.
To change a document’s preferred version:
1. Display a document’s Version History page.
2. Click the Change Preferred Version button.

Radio buttons display next to each version and the Use Latest Version option appears.
3. Do one of the following:

—  Toselect one of the existing versions as the preferred version, click the radio button next
to the version you want.

—  To always have the latest version of the document be the preferred version, click the
radio button next to Use Latest Version.

=

Click Apply.

Viewing the renditions of a version

Each version of a document can consist of a number of renditions. A rendition is the version’s
display format, such as Microsoft Word, Adobe PDF, or HTML, and can be comprised of content
files. For example, an HTML rendition of a particular document version would consist of the HTML
file and several image files if the rendition contained graphics.
To view a version’s renditions:
1.  Display a document’s Version History page.
2. Toview the version renditions, click Show Renditions.

The version renditions display and, if a rendition contains content files, those files display.

3. You can click a rendition or a content file to view it.

4. Click Hide Renditions to close the renditions view.

Viewing and changing version properties

To view and change a version’s properties:
1. Display a document’s Version History page.
2. Click the document version’s Properties icon.

The View Properties page appears.

3. Click the Edit link.

4. Change the properties you want. Click a field name for a description of each property.
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5. Click Apply.

Locking and unlocking a document

You can lock a document when you want to keep other users from editing it. To allow users to edit
a locked document, you need to unlock the document. To unlock a document, you must be the
logged-in user who locked the document. A document is locked if a Lock icon appears next to the
document icon.
To lock a document:
1. Locate the document that you want to lock.
2. From the document’s More Actions menu, select Lock.
A Lock icon appears next to the document icon. Users can view the document, but they
cannot edit it.
To unlock a locked document:
1. Locate the document that you want to unlock.

2. From the document’s More Actions menu, select Unlock.

A Lock icon no longer appears next to the document icon. Users can now edit the document.

Exporting documents

Your administrator can set up locations on external servers to which you can export documents.
You can export a single document or several documents at a time.
To export a document:
1. Locate the document that you want to export.
2. Click the checkbox that appears next to the document's title.
3. From the Edit Selected menu, select Export Document.
The Confirm Export Document page appears.
4. Inthe Location field, select the external location for the document.

5. Click the Confirm button.

Adding comments to a document

You can post comments to a document to maintain an informal commentary on it. For instance,
when co-authoring a document, you can add helpful comments for the other document authors.

To post a comment on a document:

1. Locate the document on which you want to post a comment.
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2. From the document’s More Actions menu, select Comments.

3. If there are current comments on the document, click the Add a comment link.
The Add Comments page appears.

4. Inthe Title field, enter a name for the comment.

5. Inthe Description field, enter the comment text.

6.  Click Apply.

You can view the comments on a document by clicking its Comments icon. To edit a
comment, click the comment’s Edit icon.

Scanning documents

You can add documents to your DocuShare site by scanning them. DocuShare provides two
methods for scanning documents:

. You can use a scan cover sheet to scan documents to specific locations and as new
document versions. At a multifunction device, you scan a cover sheet with a document to
convert it to PDF format and add the digital document to DocuShare as specified in the
cover sheet.

Note: The scan cover sheet feature has been optimized for use with Xerox
multifunction devices. Therefore, the feature does not support all non-Xerox
multifunction devices and software. In addition, DocuShare currently supports image-
only file formats when scanning (TIFF, non-searchable PDF, etc.). Searchable PDF file
formats are not supported for use with scan cover sheets.

. You can scan documents to a temporary scan collection that your administrator sets up on
your site. Using a WorkCentre with the Scan to File feature, you scan a document to convert
it to TIFF format and add the digital document to the temporary scan collection. You then
save the scanned document to a permanent collection on your site.

Your administrator determines which method you can use for scanning documents. Therefore,
check with your administrator to find out how your site is set up.

Scanning documents using scan cover sheets

You can scan documents to specific locations and as new document versions using scan cover
sheets. You can create scan cover sheets for these types of objects:

o documents—to scan a document as a new document version

. collections—to scan a document to a collection

. workspaces—to scan a document to the content portlet of a workspace

. user—to scan a document to your personal collection

A scan cover sheet includes a DataGlyph, which encodes machine-readable information about

the scan location and the cover sheet owner. You place the cover sheet on top of a document and
scan both to add the resulting PDF document to DocuShare.
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In addition, you can choose to create a cover sheet for a document when using the Add
Document page to upload a document. For more information, see Adding a document on
page 39.

Creating a scan cover sheet

To create a scan cover sheet:
1. Do one of the following:

—  Tocreate a cover sheet for a document, collection, or workspace, locate the object. Then
click the object’s Properties icon.

—  To create a cover sheet for your personal collection, click your username on the
navigation bar.

2. Onthe View Properties page, click the Scan Cover Sheet link.
3. Click the Create Scan Cover Sheet link.

The cover sheet is created and opens in a separate window.
4. Print the cover sheet. Then close it.

The Scan Cover Sheet page lists the cover sheet and provides the date and time at which it
was created.

Scanning a document with a scan cover sheet

If you have access to a multifunction device that supports Scan to File, you can scan a cover sheet
with a document to add a PDF version of the document to DocuShare.

Note: Since the user interface for multifunction devices can vary, the following procedure
provides general steps for scanning a document to DocuShare.

To scan a document:
1. Put the cover sheet on top of a document and place the pages in the document feeder.
Display the scan to file screen.

Follow any instructions specific to the type of device.
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Press the Start button.

The device scans the document and then adds it to DocuShare as specified in the cover
sheet.

Deleting a scan cover sheet

When you no longer want a cover sheet to be used to scan a document, you can delete it. Deleting
the cover sheet invalidates any printed copies of it. You might want to delete a cover sheet if you
misplace it and do not want anyone else to use the cover sheet.

To delete a scan cover sheet:
1. Locate the object whose cover sheet you want to delete.

2. Click the object’s Properties icon.
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3. Onthe View Properties page, click the Scan Cover Sheet link.

4. Click the Trashcan icon that appears to the right of the cover sheet.
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Scanning documents to a temporary scan collection

If you have access to a WorkCentre with the Scan to File feature enabled, you can scan documents
to DocuShare. Your WorkCentre administrator must set up a scan template before you can scan
documents to DocuShare. When setting up a scan template, the administrator can choose to save
each document page to a TIFF file or to save all of the document pages to a single TIFF file. Also,
you may be able to use a scan template to enter DocuShare property values at the device, before
scanning the document. After the document is scanned to a collection, the values you entered
appear on the View Properties page for the document.

Before you begin, check with your administrator to find out which templates are available for your
use and whether or not a password is required.

Note: Depending on which WorkCentre model you use, the steps for scanning a document
can vary. DocuShare does not support scanning color images on a WorkCentre Pro 40 using
JPEG compression (JPEG-in-TIFF).

To scan a document:

1. Place a document on the document glass or in the document feeder.

Press the Features button.

On the touch screen, press the Scan tab.

Press Scan to File.

Select the scan template.
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If the template requires a password, do the following:

a. Press Added Features.

b.  Press Filing Setups.

c.  Press Login Name/Password.

d. Press Password.

e. Type your password and press Save.

f.  Press Save.

7. If the template allows you to specify property values, enter values for the ones you want.

8.  Press the Start button.

The WorkCentre scans the document and then sends it to the temporary scan collection on your
DocuShare site. The document is stored in this collection for a designated time period. You can
check the time period by clicking WorkCentre Scan Repository on the DocuShare home page. To
keep the document, you need to save it to a permanent collection.

Saving a scanned document to a collection

To save a scanned document to a collection:
1. Goto the DocuShare home page.

2. Click WorkCentre Scan Repository.
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10.

11.

12.
13.
14.
15.

If the Passcode field appears, enter the password you entered at the WorkCentre to scan the
document and then click Enter Passcode.

Locate your scanned document.
Click Save.

If you do not want to save the document to a collection, click Delete to remove the
document from the temporary scan repository.

If you want to rotate the document, select the number of degrees from the Rotate Image
menu and click Go.

From the Document Type menu, select the type of document to save the scanned
document as.

The menu contains types in addition to Document if your administrator created custom
documents on your site.

If your administrator specified a default collection in which to save scanned documents, its
title appears in the Destination field. Do one of the following:

— If you want to use the default collection, go to step 13.
—  If you want to change the collection, click Select. The Select Destination page appears.

In the Sort By field, select Title to display the collections in alphabetical order or select
Handle to display the collections in numerical order.

Do one of the following:

—  Tofind specific collections, enter any part of a collection title in the Search field. Click
the Go button.

—  Tolist all collections, click Show All (if displayed).
—  Todisplay your favorite collections, 